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Abstract: 
 

        In this paper, we mainly focus on using new method to solve the DG 

problem in order to reducing the loss. We start from comparing two new method. We 

list out the mathematics theory of the two methods. And then, we using a 33 bus 

modeling to show which method has a better function on reducing the loss for system. 

After that, we take the better method to reducing the loss for two cases (14 bus , 34 

bus modeling). At last, we conclude the result of the research and give some comment 

on the future works. 
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Chapter 1: Introduction: 

     Distributed Generation is never a ignorable problem in the power system 

production process. We always pay a lot of time and money on the research of this 

issue. The reason of this is obviously as shown in the following table[1]: 

article 

millions 
of 

people 
affected 

location Date 
Referenc

es 

Northeast 
blackout of 
1965  

30 
the United States, 
Canada 

9 Nov 
1965 

[7]
 

1999 Southern 
Brazil blackout 

97 Brazil 
11 March 
1999 

[3]
 

January 2001 
India blackout 

230 India 
02 January 
2001 

 

Northeast 
blackout of 
2003  

55 
the United States, 
Canada 

14–15 Aug 
2003 

[5]
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article 

millions 
of 

people 
affected 

location Date 
Referenc

es 

2003 Italy 
blackout 

55 
Italy, Switzerland, 
Austria, Slovenia, 
Croatia 

28 Sep 
2003 

[6]
 

2005 Java–Bali 
blackout 

100 Indonesia 
18 Aug 
2005 

[2]
 

2009 Brazil 
and Paraguay 
blackout 

817 Brazil, Paraguay 
10–11 Nov 
2009 

[4]
 

July 2012 India  
blackout 

330 India 
30 July 
2012 

[1]
 

July 2012 India 
blackout 

670 India 
31 July 
2012 

[1]
 

            Table 1  list of notable wide-scale power outages  

If we do not or even pay less attention on this issue. The resulted power outage may 

became a disasters back on us. This paper give us an analytical method on the 

Distributed Generation and its improvements method. The author hope to put this idea 

into the analysis of the DG problem in order to make the solution of the DG problem 

more diversity. 

 1.1 Writing background: 
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      When the Great scientist Edison invented the light, our life were totally 

changed. People started to realize the importance of electricity in our life. From then 

on, people invented a lot of electricity products which have been part of our life, such 

as air condition, TV and washer. All these makes us relay on the electricity every day.  

All these bring us to think about how to transmit and distributed and generate the 

electricity appropriately in order to make us enjoy the electricity more convenient. 

And what is more, as our construction and production are more and more relay on the 

electricity in modern time. If we are failed in any part of the electricity production, it 

will lead to the power outage and a loss of even millions of dollars[2].  

     From the table1, we could see that the power outage influence more and more 

people year by year. There is no exactly loss of money. That is because the loss of 

cost are hard to account. Such kind of data always remind us to pay more attention on 

the research of the DG. This is the reason we hope to show this new method for 

solving DG problem.   

      In this paper, the method is under the theory of improve of analysis(IA) 

method. The IA method is trying to make calculation process easier by reducing the 

thesis equations and also to find a more directly analysis to get the result. In this way, 

we analysis the traditional equations to get the power loss and make a induce in 

Mathematic to get a new power loss equation. Then, we use a new analysis way of get 

the optimal DG.  
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      After getting this new method, we use Matlab code and Power World 

Simulator to prove our idea and get the simulated result. We all know that the Matlab 

calculation is a perfect tool on the optimization problem. For the Power World, we 

find this software have a strong function on analysis power flow. We only need to set 

up the modeling for power system. The result that we could get is clear and direct 

shown on the bus modeling and also formed in an Extra Excel table.  

        This paper is with the help of a serious attention and these advanced tools 

and method.  

 

1.2  Aim of the paper: 

     In this paper, we mainly focus on how to put a Distributed Generator in the best 

location of the power system to optimize the efficiency of the system. The 

Newton-Raphson method is a fast way to get the power flow. In this paper, we use 

Power world simulator to calculate the power flow. It seems that we avoid the 

Newton-Raphson method to do the power flow calculation. However, using the Power 

World simulator to calculate the power flow also need Newton-Raphson method. The 

simulator put the Newton-Raphson method in its backstage program. When we use 

the Power World we are using the Newton-Raphson method to do the calculation. 

Two new method which are similar to each other in math aspect are being bring in to 

get the optimal location for Distributed Generator. 
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     Why we choose the new method which we called IA(improve of analysis 

method) instead of the traditional optimal method? In the process of traditional 

optimal method (no matter the linear optimal method, non linear optimal method or 

some other search methods), they all have too many constraints which made the 

calculation much more complicated. The two new methods base on a simple math 

thesis which we will induce in Chapter 3.  

     Meanwhile, we use the Newton-Raphson method in getting the base power flow 

result. We all know that the Newton-Raphson method is the fastest method to 

calculate the result of power flow. No matter the iteration time or the math function, 

the Newton-Raphson method always show its obviously advantages for the 

calculation.  

      Also, the Distributed Generator in this paper is mainly used on the P-Q bus 

power system. Beside the slack bus, every bus is P-Q bus in the system which makes 

the research more focus on the optimization for the power system.  

 1.3  Structure of the paper: 

      The Chapter 1 above is the introduction part of the paper. It gives us a 

background and a reason for write this paper. Following this, we could see the basic 

knowledge in this paper. They include all the tools, methods and conception of the 

idea in this paper. In the Chapter 3, we give the details of all the modeling and 

analysis process in this paper. Then, we list out more description on the tools and 
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method in the paper. The Chapter 5 is then the results after the simulation with a brief 

analysis. The Chapter 6 is a conclusion of the paper which includes a small review of 

the whole paper.   
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Chapter 2:Basical knowledge 

2.1 Distributed generation: 

   2.1.1 Development of DG:  

      The Distributed generation is not a new conception for us. The electricity 

light our life since Edison age. Then, with the highly development of the 

electricity usage, the Distributed generations become an important issue on the 

balance, the safety, and the economics of the power system[3]. 

      The development of electricity is too fast that we almost have no time to 

make an fully arrangement. In the 1870's town gas was transported into most 

major cities in the U.S and Europe. The following figure is an early power 

plant(Figure 2-1).  
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Fig 2-1 Early Power Plant 

      By the end of 1920's, the utility grids start to become a net that spread widely 

all over the U.S. From this period of time, the grids construction speed up so fast. 

which bring the power system up to a higher level. This make people relay much 

more on electricity. Definitely, it brings up the usage and power load too much for the 

capacity of power system. In 1934, the public Utility Holding Companies Act of 1934 

restrict the companies that could participate the active of the power system 

construction, distributed , usage. No everyone could now participate into the power 

system construction , design and production. This leads the power system activities to 

the large scales age. However, the technology could not support the operation for the 

large scales of the power system. In 1992, government start to require the interstate 
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transmission line owners to allow all the electric generators access to their lines. It 

begin the age that power system needs distributed again. So, when we look back to 

the history of the distributed generation for system, we could see it is the 

Distributed-Centralized-Distributed process[2]. 

 2.1.2 Technology of the DG:    

       The Distributed generation is any small-scale electrical power generation 

technology that provides electric power at or near the load site; it us either 

interconnected to the distribution system , directly to the customer's facilities, or both. 

DG could get us  multitude of services to all the utility and consumers, such as 

capability adjust, peak sharing, generation allocation confirming, balance of the power 

system.[4] In an addition, the DG could predict the power outage and monitor the 

status of the power system. As the basic science, more and more new method are used 

in the DG technology which bring the DG much more advantage.  

      In this paper, we mainly focus on how to allocated the DG to balance the 

power system distribution.  

2.2  Improve of analysis (IA): 

      To solve the problem of the Distributed Generation, many method have 

already been used. The major methods are from optimization view. The traditional 

optimization always need to set up a objective function. In the DG problem, the 

objective are always about cost, power, power loss and so on. Then, we need to find 
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all the rated parameters for the objective to set up the subjective functions. When we 

put all them together. we could use Matlab code to realize the calculation. However, 

when we need to do more than one optimization, such as we need get maximized 

power Meanwhile the minimized cost. In this case, we will need to set up objective 

and subjective function for two times. It makes the process of solving the problem 

more complex. So, later, we bring the GA method in to the DG problem. The GA 

method is easily for dueling with the multiple objective functions problem. But , The 

GA method has a big problem. It takes too much time for calculation. These problem 

and inconvenient make us try to find a better method. So, we start from the 

optimization itself to see if we could have improve of the method. because the 

definition of optimization means to find the best values. It is a method to find the 

extreme .[5] [6]In this way, if we could find the extreme value. We are able to finish 

the optimal process. think of this ,we could go back the objective function. find the 

related function for the objective vector. And then , we do some math inducing to get 

the extreme value. This process is called improve of analysis method.[7] 

2.3 Power World simulator: 

  2.3. 1.Introduction of the Power World: 

      The Power World Simulator power system simulation visualization software 

developed by University of Illinois School of Electrical and Computer Engineering 

can display the visual image of the operation of the power system. Users can create, 
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change various power system models and parameters for various operations in the 

emulator. This would analysis the model on failure and economic operation and so on 

The design of Power World is user-friendly, and highly interactive nature. It faces to 

all the user who want to analysis a special power system no matter you are 

professional or not.  

       This simulator is a integrated product. Its strong function is on the calculation 

of the Power Flow. It could calculate a system with even 100,000 nodes. So, it could 

analysis the system all by itself. Unlike the others software for calculating the Power 

Flow, the Power World simulator allows users to observe detailed panorama of the 

power system vividly. In addition, the system model can easily be modified by using 

the simulation software graphics editing tool. What the user need to do is only click 

the part that your want to change in the figure of the system. Then, the detail 

parameter of that part will shown in another window. The user could then revise 

everything in that window easily. [8] 

     Power World simulator mostly use the mouse to complete the exchange with 

the user, the interface follows the practice of using a mouse. In general, the left mouse 

button can directly modified and control the system equipment while the right can be 

used to view detailed information about a device, or a list view option. It also 

provides some special usage on mouse.  
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        Power World simulator many functions can be accomplished by using the 

toolbar. The toolbar also includes a lot of control bar, which can be activated by the 

mouse. A total of eight toolbar, as shown below, from left to right, from top to bottom 

as follows (figure 2-2):[9] 

 

Fig 2-2 Power World simulator functions table 

        1. File column: Through this column, one can save, print, reading and other 

operations. This column also provides online help and troubleshooting tool model. 

Power World simulator allows users to use several different formats to store the 

system model. If we look at file in the main menu, then select Save As dialog box 

items can appear in the lower left corner of the dialog box to store the file type 

column to select the desired save format. Simulator can be used to store the model in a 

variety of binary format (the default), the version used in a variety of PTI primitive 

data types, IEEE common format. 

        2. Program column: In this column the use could switch the program to edit 

or run mode in order to control a variety of information in power flow calculation. 

This column includes the following options:  

         a. Edit Mode: Edit mode is used to create new models and modify existing 

models. Program by clicking on the column "Edit Mode" button (EDIT MODE) could 
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switch to this mode. In this mode user could do the following operation: Create a new 

model; increase in existing component models; modify the physical appearance of the 

one-line diagram; view and modify the model useless chart shows, etc.; 

         b. Run Mode: This column provides some basic operation button operation 

mode. You can control the simulation start, continue, pause, and display graphs, 

switching single line diagrams. In this mode, the timing simulation can be animated, 

which could achieve single-step flow calculation and the time domain simulation of 

power systems. In the Options panel click "Run Mode" button to enter the run mode. 

Key features include: one-line diagram can be viewed through a graphical model; 

model information (Case Information) shows that by table shows the diagram to see 

the entire power system; computing trend by changing the simulation options and 

dialog boxes; translated on any node load, parallel branch and electricity; voltage 

curves; power transfer distribution factor (PTDF) is calculated; based on trend 

research conducted purely economic analysis in time domain or user customized, etc. 

        c. Single step to solve (only in Run mode): single-step flow equations are 

solved with respect to the timing simulation purposes. This button allows the user to 

simulate the trend of an independent system. 

        d. Log: This button can turns on or off the log window. The window 

displays the progress of the process flow calculation and research to help 

non-convergence model; 
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        e. Abort: terminate the ongoing flow calculation. If the program is 

performing a timing simulation, abandoned by (ABORT) key to abort the execution 

of the program. 

         3. Image zoom bar: to show the complex power system diagram, Power 

World simulator can zoom in and move the single-line diagram. One can directly 

specified in enlarged size in this column ,and could also set the magnification by 

selecting a rectangular area in Figure. This column contains a dialog box, you can 

select it as the center of the display to a bus line diagram.   

         4. Options / Information Bar: Through this column, you can quickly access 

relevant information and setting options Power World simulator. You can set options 

related to simulation and solution, define the filter display, single-step flow 

calculation, create a quick tide tables, display specific information about a node, or 

switch to another line diagram. 

         5. Unfolding column: This column provides another move / zoom control. 

Used to adjust the arrow in Figure 4 of the display range. Another two buttons can be 

used to scale the image. 

         6. Format Bar (only in edit mode): Through this column, you can change 

the font, color, style, graphics and magnification level and so on. The default value 

may be set different parameters of the drawing, and reset these values when necessary. 
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Button in this column focused on the main menu, most of the "Format (FORMAT)" 

item. 

        7. Edit bar (only in edit mode): This column includes some model editing 

tools. Can cut or copy a single device on the line diagram and paste it in the original 

or other figure. Can also be a group of the same elements by the normal operation of 

the selection rectangle, or circle operation. 

         8. Insert bar (only in edit mode): Use this column button to add draw on an 

existing line diagram of the new component. These groups include the element of 

power system components such as nodes, power lines, transformers, loads, generators 

and "areas (AREA)", "area (ZONE)" as well as "pie (PIE CHART)" to provide 

advisory information box pieces. You can also add a text box or display box rectangle, 

ellipse, arc and other shapes, and these have nothing to do with the system other 

equipment. Button in this column focused on the main menu, most of the "Insert 

(INSERT)" item. 

2.3.2 Some useful functions: 

      Double-click Power World Simulator Icon , which starts Simulator. 

Simulator can be used to create new models, modify existing models, and electric 

power system simulation. In the following example, we will create a new model from 

scratch.[10] 

step 1: set up a new folder: 
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        To create a new model from the main menu, select File> New Case , Or 

click the New icon  on the toolbar. Background window of the screen will turn 

white, which is modeled Power World default when the background color. As using 

single line wiring diagram in power system analysis, it uses single line to represent 

the actual three-phase power system consists of a three-phase component 

composition. 

 step2 : add a bus: 

       1.Choose Insert> Bus from the main menu, or bus icon on the toolbar. This is 

a preparation for adding a new bus for the Simulator 

       2. Left-click the wiring diagram that you want to place the new bus, it will 

pop up the Options dialog box (Bus Option Dialog) (as shown in Figure 2-4). This 

box can be used to define the name of the bus, direction, size, width, area, regional 

and rated voltage, and is connected to the load and shunt compensator bus. 

        3. Next, check the bus system balance (System Slack Bus) option, which is 

located Bus Voltage Bus Information option under item (see Figure 2-5). Bus is used 

to ensure a balance between supply and demand balance of imaginary power system 

equipment. In other words, the balance of the bus system balanced the losses caused 

by the energy difference. 
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       4. Click on the OK button Bus Option Dialog, ending bus definition and 

close the dialog box. After closing the dialog box, the new bus is displayed in your 

selected location. 

 

Fig 2-4 Bus Option in power world 
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Fig 2-5  Important information in Bus Option in power world 

 

     step 3: add a generator: 

      1.Choose Insert> Generator from the main menu Generators icon, or click on 

the toolbar  

      2. Left-click the bus in wiring diagram need to connect the generator (in this 

case, click on balancing the bus, that bus One), Generator Options dialog box 

(Generator Option Dialog) will open automatically (see Figure 2-6). This box set 

features can be used to determine the new generators, display size, orientation, and its 

upper and lower output power, reactive upper and lower voltage set point and cost 

curves.  
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      3 After adding the generator, there should be an output power value defined. 

Then, we need to ensure active (MW) and voltage (Voltage) option controls are chose. 

Entering '413' in the power output (MW Output) box. Note: The balance of the system 

bus connected to the generator output power can be Arbitrarily ,as the actual load and 

the loss of output power of the generator is depending on the system. 

      4. Clicking display information (Display Information) button. Direction 

(Orientation) option is used to define the direction of the generator connected to the 

bus. Lock (Anchored) after a single box is checked, when the bus moves, the 

generator moves also. 

      5. Click OK in the generator option (Generation Option Dialog), accept the 

default values for the remaining options. After the dialog box closed, the new 

generator will appear in the wiring diagram on the selected bus. The wiring diagram is 

similar to Figure 2-7 
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Fig 2-6 Generator Option in Power World 

 

Fig 2-7 Generator figure in Power World 

      Step 5 Add another stripe load bus 

        Add the second bus operation 

       1.Choose From the main menu Insert>Bus, or Click on the icon in the toolbar 

for bus bar 
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          2.In the wiring diagram, click on the right side of the first bus somewhere, in 

figure 2-8. in (bus options dialog), Keep the bus number As the default value 2, and at 

(bus name) type ‘two’ 

        3.At bus bar, add one 200MW, 100Mvar load. Click (attached devices). At 

(load summery information), type 200 at (base MW), and at (base Mvar), type 100 

        4.Click ok. Accept all other default values. Closed bus bar options dialog, 

and Add on the bus 

        At this moment, on the wiring diagram, don’t show the load on bus bar 2. 

Although in System model file, it has been a load. 

        On the wiring diagram, the operation to add load is: 

        1.From the main menu options, choose Insert>Load, or click Load icon 

             2.Left-click in the middle of the bus. Load options dialog (figure 2-9) is open. 

At (constant power), show the 200MW, 100Mvar load  
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Fig 2-8 bus options dialog in Power World 
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Fig 2-9 Load options dialog in Power World    

 

       3.Click (load information), choose up to Make the load direction Facing up. 

Make sure that (anchored box) is chosen in order to let load move with bus bar. 

   4.Click ok, accept all other default values. Close dialog and now each Load 

automatically is equipped with a circuit breaker. 

 

Move components in the wiring diagram 

    1.Left-click on the element to move, Drag the element to a new location.  

    2.Move bus bar 2, Left-click on bus bar 2. Drag the element to a new location. 

Now the writing diagram is figure 2-10 

 

Fig 2-10 Figure for load and generation in Power World 

  Step 6 add transmission line 

   Line can connect each bus, and the steps are shown below: 

         1.In the main menu, choose Insert>Transmission Line, or click (AC 

transmission line). 
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         2.Left-click on the origin of transmission line, which is usually located in 

add lines is connected at one end of the bus. 

          3.Lines and transformer are drawing in series. Click the mouse at a time, 

Loosen and drag the mouse, a route is extended from the starting point. Click the 

left mouse button at a time, the line appears a fragment. Every Click the mouse to 

terminate a line, on a line will appear a vertex. Move the mouse to the next point, 

between two points will appear a new line in the middle. 

         4.To end drawing lines, Double-click the left mouse button at the end of 

hope. 

         5.(Transmission line/transformer dialog) appears (as in figure 2-11). 

Number 1 appears in (from bus number) and number 2 appears in (to bus number). 

           6.(Series resistance), (series reactance) and (shunt charging) are used to 

Input   lines per unit length parameter values. In (resistance), type 0.02, 

(reactance)0.08,(shunt charging) 0.1. 

           7.(Limit (MVA)) is used for power capacity of line. In limit A (MVA), 

type 1000, other limit (MVA) is for other chapters. 

           8.Click ok and accept all other default values. Close (transmission 

line/transformer dialog), new lines are added to the diagram. 
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Fig 2-11 Transmission line/transformer dialog in Power World 

   

2.4  Optimization: 

   2.4.1 Description of optimization:   

    No matter in the basically science such as mathematics, or the application 

science like computer science and management science. mathematical optimization 

(alternatively, optimization or mathematical programming) is the selection of a best 

element (with regard to some criteria) from some set of available alternatives.  

     In an easy case involved the optimization, the problem always made up by 

maximizing or minimizing a real function which we could get the input values from 

within an allowed set and then compute the result for the function.[11] [12]Also, 

optimization theory and techniques to other formulations include applied mathematics. 

What is more, optimization needs to reach "best value". Those value for the objective 



 

function need to be constrained in a 

different kinds of objective function and domains. 

      2.4.2 Optimization problem:

    The optimization problem is able to be defined as follo

R from some set A to the real 

≤ f(x) for all x in A ("minimization") or such that f(x0) 

("maximization").Such a formulation is called an optimization problem or a 

mathematical programming problem (a term not direc

programming, but still in use for example in linear programming 

below)[16]. Using this technique, the physics

on energy minimization, making the function f value as 

modeled.[17][18] 

Commonly, A is Euclidean space's subset. This A is always explained by a set of 

constraints, equalities or inequalities which the A's members need to match with. The 

A is named as search space or the choice set. 

   The function f is called, variously, an objective function, a loss function or cost 

function (minimization), indirect utility function (minimization), a utility function 

(maximization), a fitness function (maximization), or, in certain fields, an energy 

function, or energy functional. A feasible solution that minimizes (or maximizes, if 

that is the goal) the objective function is called an optimal solution.
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function need to be constrained in a defined domain. And those include many 

different kinds of objective function and domains. [13][14][15] 

2.4.2 Optimization problem: 

The optimization problem is able to be defined as follow: Given: a function f

R from some set A to the real numbers Sought: an element x0 in A such that f(x0) 

 f(x) for all x in A ("minimization") or such that f(x0) ≥ f(x) for all x in A 

("maximization").Such a formulation is called an optimization problem or a 

mathematical programming problem (a term not directly related to computer 

programming, but still in use for example in linear programming – see History 

Using this technique, the physics and computer problem are mainly focus 

on energy minimization, making the function f value as energy of the system being 

Commonly, A is Euclidean space's subset. This A is always explained by a set of 

constraints, equalities or inequalities which the A's members need to match with. The 

named as search space or the choice set.  

n f is called, variously, an objective function, a loss function or cost 

function (minimization), indirect utility function (minimization), a utility function 

(maximization), a fitness function (maximization), or, in certain fields, an energy 

energy functional. A feasible solution that minimizes (or maximizes, if 

that is the goal) the objective function is called an optimal solution.[19][20][21]

defined domain. And those include many 

w: Given: a function f : A 

numbers Sought: an element x0 in A such that f(x0) 

 f(x) for all x in A 

("maximization").Such a formulation is called an optimization problem or a 

tly related to computer 

see History 

and computer problem are mainly focus 

ystem being 

Commonly, A is Euclidean space's subset. This A is always explained by a set of 

constraints, equalities or inequalities which the A's members need to match with. The 

n f is called, variously, an objective function, a loss function or cost 

function (minimization), indirect utility function (minimization), a utility function 

(maximization), a fitness function (maximization), or, in certain fields, an energy 

energy functional. A feasible solution that minimizes (or maximizes, if 

19][20][21] 
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   As the convenience consideration, we always translate optimization problem as 

minimization problem. Commonly, several local minima are existing, expect that both 

objective function and feasible region are convex in a minimization problem. Here, a 

local minimum x* is defined as a point for which there exists some δ > 0 so that for 

all x such that (2-1):[15][16][22] 

                       �� � ��� � �                           (2-1) 

the expression (2-2) 

                                   �	��
 � �	�
                            (2-2) 

hold; it means, all of the function values should be at lease no less to the value at that 

very point on some region around x*. It is similar with local maxima.  

    Many algorithms proposed for solving non-convex problems (including the 

majority of commercially available solvers) are not good enough for making a 

difference between local optimal solution and rigorous optimal solutions, and even 

mistake the former as actual solution to the original problem[23].The branch of 

applied mathematics and numerical analysis that is concerned with the development 

of deterministic algorithms that are capable of guaranteeing convergence in finite time 

to the actual optimal solution of a non-convex problem is called global 

optimization.[24]  

  2.5 Power Flow: 

   2.5.1 Conception: 
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    In power engineering field, the power flow study which is also called load flow 

study is being used as a tool with numerical analysis in power system. A power flow 

study prefer simplified notation like one line diagram and per-unit system, and mainly 

focuses on various forms of AC power (i.e.: voltages, voltage angles, real power and 

reactive power). It gives an analysis on steady -state operation for power system. 

There are a lot of software could solve the power flow problem.[25] 

     As an addition study of power flow, which is sometimes called the base case, 

some other analysis like short-circuit fault analysis, stability studies (transient & 

steady-state), unit commitment and economic dispatch are also completed by software. 

Some programs make use of LP(linear programming) for finding the optimal power 

flow, the conditions that give the lowest cost per kilowatt hour delivered.    

     Power flow (load flow) studies have important status in further research of 

power system just like in determining the best operation of existing systems. The  

principal information  that we could get from the power-flow study is the magnitude 

and phase angle of the voltage at each bus, and the real and reactive power flowing in 

each line. 

      Commercial power system are not able solved by hand in power flow 

calculation only because it is too large. So that, in the year between 1929 and the early 

1960s , special purpose network analyzers were set up for building laboratory models 

of power system which replaced the analog method by large-scale digital computers. 
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2.5.2 Model: 

    An AC power-flow model is a model used in electrical engineering to analyze 

power grids. It gives a nonlinear system which describes the energy flow through 

each transmission line. Due to nonlinearity, in many cases the analysis of large 

network via AC power-flow model is not feasible, and a linear (but less accurate) DC 

power-flow model is used instead. Both of those models are very crude 

approximations to reality.[25] 

2.6 Iterative method: 

    Commonly, we use the iterative method to solve problems of nonlinear 

programming. And it would be different when the method is used to solve the 

Hessians, gradients, or only function values. While evaluating Hessians (H) and 

gradients (G) improves the rate of convergence, for functions for which these 

quantities exist and vary sufficiently smoothly, such evaluations increase the 

computational complexity (or computational cost) of each iteration.[26] 

    One major performance of optimizers is just the number of required function 

evaluations as this often is already a large computational effort, usually much more 

effort than within the optimizer itself, which mainly has to operate over the N 

variables[25]. The derivatives could list out detailed information for such optimizers, 

and it could be even harder. such as approximating the gradient takes at least N+1 
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function evaluations. The number of function is in the order of N² when we get the 

2nd derivatives (collected in the Hessian matrix). Newton's method requires the 2nd 

order derivates, so for each iteration the number of function calls is in the order of N², 

but for a simpler pure gradient optimizer it is only N. However, gradient optimizers 

need usually more iterations than Newton's algorithm. Which one is best with respect 

to the number of function calls depends on the problem itself.[27] 

2.7 Power loss: 

   The fraction of energy lost to resistance would be reduced when transmitting 

electricity is at high voltage. However, this varies depending on the specific 

conductors, the current flowing, and the length of the transmission line. When, think 

about a known power line, a higher voltage brings the current down and then the 

resistive losses in conductor. For example, raising the voltage by a factor of 10 

reduces the current by a corresponding factor of 10 and therefore the I2R losses by a 

factor of 100, provided the same sized conductors are used in both cases. Even if the 

conductor size (cross-sectional area) is reduced 10-fold to match the lower current the 

I2R losses are still reduced 10-fold.[28] 

      Long-distance transmission always  happen through the line overhead with 

the voltage of 115 to 1,200kV. When the voltage come to more than 2,000kV between 

the conductor and the ground, corona discharge losses can offset he lower resistive 
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losses in the line conductors for it is too large. . Measures to reduce corona losses 

include conductors having larger diameters; often hollow to save weight, or bundles 

of two or more conductors. 

   Transmission and distribution losses in the USA is considered to be at 6.6% in 

1997 and 6.5% in 2007. We successfully cut in half of the transmission losses by 

using underground DC. Underground cables, as they have no constraint of light 

weight than overhead cables. It can be larger diameter. Commonly, losses are 

estimated from the discrepancy between power produced (as reported by power plants) 

and power sold to end customers; the difference between what is produced and what 

is consumed constitute transmission and distribution losses, while we assuming no 

theft of utility occurs.[29][30] 

2.8 Newton- Raphson method: 

         In calculus, Newton's method is an iterative method for finding zeros 

(solutions to equations of the form 	�	�
 � 0). In optimization, it is applied to the 

derivative of a function to find its zeros (solutions to f'(x)=0)), also known as the 

stationary points of the differentiable function f(x). Newton's Method attempts to 

construct a sequence xn from an initial guess x0 that converges towards x* such that 

	�
	x�
 � 0. This x* is a stationary point of f(.)[31] 
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The second order Taylor expansion fT(x) of a function f(.) around xn (where 

� � � � � �� is (2-3):  

                     ��	�� � ∆�
 � ��	�
 � �	��
 � ��	�
∆� � �
� ���	��
∆��,        (2-3) 

and attains its extremum when its derivative with respect to∆� is equal to zero, i.e. 

when ∆�solves the linear equation (2-4): 

             	��
 � ���	��
∆� � 0                            (2-4) 

(Considering the right-hand side of the above equation as a quadratic in∆�, with 

constant coefficients.) 

    Thus, provided that f(x) is a twice-differentiable function well approximated by 

its second order Taylor expansion and the initial guess x0 is chosen close enough to x*, 

the sequence (xn) defined by (2-5):  

∆� � � � �� � � ��	��
���	��
 

                                                    ���� � �� � ��	�

���	�
 , � � 0,1, … …                (2-5)     

will converge towards a root of f' , i.e. x* for which �
	x�
 � 0. [32][33][34] 

      You would probably have some difficulty when you hope to get the root of a 

complicated function. Lucky, we have Newton-Raphson method. Using this method, 

we could be easier to get roots of complicated functions in numerically evaluating. . 
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This iterative process follows a set guideline to approximate one root, considering the 

function, its derivative, and an initial x-value. 

       It is known to all that an "0" of the function should be one of a root for the 

function in mathematics aspect. It is equal to say that the function which equals to "0" 

is at the location of root. It is no a hard work to find root such as �	�
 � �� � 9 as 

follow(2-6):[34][35][36][37] 

�	�
 � �� � 9 � 0 

	� � 3
	� � 3
 � 0 

                          � � 3 !" � � �3                       (2-6) 

        The Newton-Raphson method start from the iteration. Then, it will 

gradually come close to a root for function. The root that we get in this way depends 

on the initial, arbitrarily chosen x-value (2-7).  

                           ���� � �� � �	�#

��	�#
                       (2-7) 

      So, we could get that xn is the original X-value that we know. f(xn) is the  

result value when we give the xn to function. f'(xn) is the derivative (slope) at xn.  

xn+1 here is the next x-value that you are searching for in the iteration process. Here, 

we should pay attention that as the f'(x) equals to f(x)/dx, the f(x)/f'(x) could get  a 

value of dx. 
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     The dx will be close to 0 if the iteration number increases It is curial if the 

Newton-Raphson method is preformed. That is what we need to pay attention to. Take 

the f(x) = x2-4 as example. Below are listed the values that we need to know in order 

to complete the process (2-8).  

�	�
 � �� � 4 

                                                            � ′	�
 � 2�      x0=6                  ( 2-8) 

                                                                                  

Theoretically, the more uncountable number on iterations we do, the more exactly we 

could reach to the root for function. Actually, this is the not what we hope to use 

because it is a numerical method that we use to search for the root in a easily way. So, 

we will assume process has worked accurately when our delta-x becomes less than 

0.1.Such kind of precision should be different in different situation. So , how much 

exact we need to use is different depending on each situations. The table (Table 2-1 ) 

below list out the execution of the process.  

n xn f(xn) f'(xn) xn+1 dx 

0 x0 = 6 f(x0 = 32) f'(x0 = 12) x1 = 3.33   

1 x1 = 3.33 f(x1) = 7.09 f'(x1) = 6.66 x2 = 2.27 dx = 1.06 

2 x2 = 2.27 f(x2) = 1.15 f'(x2) = 4.54 x3 = 2.01 dx = .26 
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3 x3 = 2.01 f(x3) = 0.04 f'(x3) = 4.02 x4 = 2.00 dx = 0.01 

Table 2-1 initial x table 

       So, starting with x0=6, we could get the root of function f(x) = x2-4 is x=2. If 

we chose another initial x-value, we could find the same root, or we may find the 

other one, x=-2. 

      A graphical could also help us. In the following graph (Figure 2-12), we could 

see the function f(x) = x2-4 as blue line. The process we use is as before. IN the first 

iteration, the red line is tangent to the curve at x0. The slope of the tangent is the 

derivative at the point of tangency, and for the first iteration is equal to 12. Dividing 

the value of the function at the initial x (f(6)=32) by the slope of the tangent (12), we 

find that the delta-x is equal to 2.67. Subtracting this from six (6) we find that the new 

x-value is equal to 3.33. Another way of considering this is to find the root of this 

tangent line. The new x-value (xn+1) will be equal to the root of the tangent to the 

function at the current x-value (xn).[38][39][40] 



 

Fig 2

         The Newton-Raphson method

in some problem while doing the iteration

would be the result if we 

and could not get through. What is more? If you start with x=1 to solve the function of 

f(x) = x1/3. Do the x-values converge? Does the delta

           So, here, we should pay attention to the u

method. When, we focus on some reality project, this problem become more 

obviously. It is when we are trying to do the derivation we may ignore that the final 

result may be influenced by many different factors[41].

factor that involved in function for result. They are all the variables. When we think 

about this situation, we could easily think about using the partial derivatives. So, we 

 

36 

Fig 2-12     Graph for NR method 

Raphson method is not a "always right" choice. It will bring 

in some problem while doing the iteration. First, think about the above example. What 

if we start from x=0? We would have a "division by zero" error, 

could not get through. What is more? If you start with x=1 to solve the function of 

values converge? Does the delta-x decrease toward zero (0)?

So, here, we should pay attention to the using of Newton-Raphson 

method. When, we focus on some reality project, this problem become more 

obviously. It is when we are trying to do the derivation we may ignore that the final 

nced by many different factors[41].we need to consider

factor that involved in function for result. They are all the variables. When we think 

about this situation, we could easily think about using the partial derivatives. So, we 

 

It will bring 

the above example. What 

have a "division by zero" error, 

could not get through. What is more? If you start with x=1 to solve the function of 

x decrease toward zero (0)? 

Raphson 

method. When, we focus on some reality project, this problem become more 

obviously. It is when we are trying to do the derivation we may ignore that the final 

we need to consider all the 

factor that involved in function for result. They are all the variables. When we think 

about this situation, we could easily think about using the partial derivatives. So, we 
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could get a function with all the factor involved as variables and try different partial 

derivatives to solve the problem to get the result more exactly.     
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Chapter 3: Modeling: 

3.1 DG modeling: 

      Distributed generation is any small-scale electrical power generation 

technology that provides electric power at or near the load site; it is either 

interconnected to the distribution system, directly to the customer's facilities, or 

both[]. From the previous chapter, we know that many different define were given to 

the Distributed Generation by many famous agencies. In this paper, The distributed 

generation are served in for the PQ bus power system as follow: 

 
   Fig. 3-1 PQ bus mode 
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    In this paper, the Distributed Generation are used to put in a certain bus in the 

system in order to optimize the efficiency of power system. In the figure above, we 

could see that the power system has 37bus. Beside the bus1 which is the slack bus, the 

others are all the PQ bus. The power system we use in paper as the modeling are the 

same like the figure above. What we have done in this paper is to find the optimal 

location and size of the Distributed Generator in order to get the optimized power loss 

later. 

 

3.2 Power loss modeling: 

      In order to get the math function for the new method which could avoid too 

many complex constraints. we have two derivation parts. The first one here is to get 

the power loss function for the new method. The second one is later to getting the 

optimal size for the system.  

 3.2.1 Idea of the Power loss equation: 

      In the original power loss equation, we need to consider the angle, line current 

and the magnitude of the bus voltage. What we hope to do is do find a equation that 

related the power loss only to the active and reactive power. So, here, we try to 

derivate such a loss formula. 

 3.2.2 Mathematics derivation: 
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      In the [42], the author list out his idea about how to get a new power loss 

equation. First of all, we start with the network losses by simply adding the bus 

powers at the n buses of the network. We clear that the bus power Si injects into bus i 

which means the generated power minus the bus load. To consider all the bus in the 

whole system, we could easily get the total generated power minus the total load; i.e., 

we get the total network losses as follow equation (3-1)(3-2): 

S� � P� � jQ� * P+� � P,� � j	Q+� � Q,�
 

                 S� � P� � jQ� * P+� � P,� � j	Q+� � Q,�
         (3-1) 

   

           P- � jQ- � ∑ S/0/1� � ∑ V/J/�0/1�                        (3-2) 

 According to the following equation equation(3-3): 

                 x4y * ∑ x/y/0/1�                             (3-3) 

 The above equation could be just written as following: 

                               P- � jQ- � v7894 J789�                                                  	3 � 4
 

  By put the follow equations in the above equation: 

                  Vbus=ZbusJbus                                 (3-5)  

	A � B
4 � A4 � B4 

	AB
4 � B4A4 

                                                                   	A4
4 � A                            

( 3-6)   
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    We could get: 

                P- � jQ- � J7894 Z7894 J789� � J7894 Z789J789�                          (3-7) 

   The last step follows because Zbus is a symmetric matrix. 

       In this way, the bus impedance matrix is the sum of  bus resistance and bus 

reactance matrix as follow equation(3-8): 

            Z 789 * R � jX � ?r�� … r�0
r0� r00

A � j ?x�� … x�0
x0� x00

A        (3-8) 

       Also, we could list out the bus current vector which is the sum of a real and 

reactive part vector as following: 

       J789 * JB � jJC � ?JB�…JB0
A � j ?JC�…JC0

A                         (3-9) 

   So, the equation (3-7) could be written as: 

      P- � jQ- � DJB � jJCE4	R � jX
	JB � jJC
                      (3-10)   

      Focusing on the real part of this matrix product, we could get: 

       P- � JB4RJB � JB4XJC � JC4RJC � JC4XJB                          (3-11)   

       As the X is a symmetric matrix, we could easily find that the second and the 

fourth part of the equation are the same so that we could obtain the next formula for 

PL equation(3-12): 

                                 P- � JB4RJB � JC4RJC                               (3-12) 

        or by using index notation, 

                              P- � ∑ rFGDJBFJBG � JCFJCGE   0/1�G1�                        (3-13) 
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         The above equation shows the total loss power in the manner of the bus 

current. To us, we are more likely to put the bus power and bus voltage in the 

equation instead of the current. So, we make a change as equation(3-14): 

              P/ � jQ/ � V/J/�  
                                                � V/DJB/ � jJC/E 

                                                � |V/|	cos δ/ � j sin δ/
DJB/ � jJC/E                    	3 � 14
        

       The δ/ is the phase angle of V/ with respect to the reference bus voltage. By 

separating the real and imaginary parts of the equation(3-14), we could certainly get  

equation(3-15) as follow: 

JB/ � 1|V/| 	P/ cos δ/ � Q/ sin δ/
 

                                       JC/ � �|OP| 	P/ cos δ/ � Q/ sin δ/
               (3-15) 

      If we do a substitution on the equation(3-14 ) that we put the equation(3-15) 

above as the current part into this loss equation, we get PL, after some algebraic step, 

we get the following express form as equation(3-16): 

 P- � Q RαFGDPFPG � QFQGE � βFGDQFPG � PFQGES                         	3 � 16
0

F1�G1�
 

       For brevity in notation, we introduced two new parameter which will make 

the equation look more simply: 

     αFG * rFGUVFU|VG| cos	δF � δG
 

                                          βFG * VWXUOWU|OX| sin	δF � δG
            (3-17) 
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3.3 Optimization modeling: 

      Then ,we need to think about how to get the minimized power loss which 

means how could us optimize the location for the Distributed Generator in order to 

minimize the power loss.    

 3.3.1.Idea for the optimization:    

     We could learn from chapter 2 that we need to find the connect point for the 

subjective function and objective function. That means we need to push the subjective 

function on to objective function to make a cross. And as the objective function. It is 

not too hard to judge that when the cross make only one connect point. It is a special 

situation. It remains us that when we get the partial derivative of any function and 

make it equal to zero, we could find the extreme value. Here, if we get this point. It 

should be the optimal point because the line include the extreme value is tangential to 

the objective function. So that, this point must be the minimize point that make power  

loss minimized, as following figure 
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                  Fig. 3-2 Optimization idea 

That is the optimal point for the active power in each bus. And then, as we have the 

relationship in the bus injection as following figure, we could replace the bus injection 

(bus) active power with the generator active power.  

 
Fig 3-3 Bus node figure 

3.3.2 Mathematics derivation: 
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       As we get the idea for derivation the equation for getting the location and 

size for Distributed Generator, we start with the partial differentiation of power loss 

with respect to PGi; which is eq(3-18): 

∂P-∂P/ � Q ∂∂P/ ZαFGDPFPG � QFQGE � βFG	QFPG � PFQG
[0

F1�G1�
                	3 � 19
 

As we know 
                              P/ * P+/ � P,/                                                                    	3 � 20
 

       The equation(3-19) above is the partial differentiation for real power.  

Index Term 

j k 
∂∂P/ 	αFGPFPG
 

∂∂P/ 	αFGQFQG
 
∂∂P/ 	βFGQFPG
 

∂∂P/ 	�βFGPFQG
 

j=i k=i 2P/α// 0 0 0 

j=i k^i PG	α/G

� P/ ∂α/G∂P/ 
 

Q/QG ∂α/G∂P/  Q/PG ∂β/G∂P/  �QG	β/G

� P/ ∂β/G∂P/ 
 

j^i k=i PF	αF/ � P/ ∂αF/∂P/ 
 QFQ/ ∂αF/∂P/  QF	βF/ � P/ ∂βF/∂P/ 
 �PFQ/ ∂βF/∂P/  

j^i k^i PFPG ∂αFG∂P/  QFQG ∂αFG∂P/  QFPG ∂βFG∂P/  �PFQG ∂βFG∂P/  

                               Table 3 

       However, because the above equation has four parts if we unfold the equation 

above. we need to think about the relationship between the j, k. The results turn into 
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many different situations. which is based mainly on the value of j , k that they get. In 

the above table, we make the summarize. 

        when we get the table above, we could put them together as the whole 

partial derivation equation as follow (3-21). 

  
_`a_`P �2P/α//                                                    

             � ∑ Rα/GPG � β/GQG � 	P/PG � Q/QG
 _bPX_`P � 	Q/PG � P/QG
 _   
_`PS0G1�Gc/      

             � ∑ RαF/PF � βF/QF � DP/PF � Q/QFE _bWP_`P � DQFP/ � PFQ/E _dWP_`P S0F1�Fc/         

             � ∑ ∑ ZDPFPG � QFQGE _bWX_`P � DQFPG � PFQGE _dWX_`P [0G1�Gc/
0F1�Fc/

               (3-21) 

  If we could understand that   

αGF � αFG     

                              βFG � βGF                        (3-22) 

    We were also able introduce the shorter symbols: 

∂αFG∂P/ * αFG�  

                             
_dWX_`P * βFG�                          (3-23) 

     The we could reduce the equation(3-21), as  

            _`a_`P � 2 ∑ 	PGα/G � QGβ/G
0G1�                         

             =   ∑ eDPFPG � QFQGEfαFG� � 	PFQG � QFPG
0F1�G1�
βFG�             (3-24)  

      From this equation(3-24) we may find that it is not convenience to do the 

calculation. We 'd better try to get a clearer expressions for the partial derivatives. 
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This may not be a difficult thing for us to duel with if we take a look at what we have 

already done. 

       With the differentiating the expression for αFG and β/G which is list out by 

equation (3-22),we get: 

     
_αWX_`P * αFG′ � � VWXUOWU|OX| sinDδF � δGE 	_δW_`P � _δX_`P
  

      
_βWX_`P * βFG′ � VWXUOWU|OX| cos	δF � δG
	_δW_`P � _δX_`P
                        (3-25)  

 

        we then take the expression for the Pi for the equation that we all know as 

the following equation(3-26) 

            `PgFhPOP� � y/�V� � y/�V� � i � y/0V0    for i � 1,2,   , n              (3-26) 

     we then ,get: 

                                  P/ � Rek∑ y/lVlV/�0l1� m                               (3-27)                                            

since: 

                        V/� � |V/|egFδP                             (3-28)                                                        

 

and then 

                                                Vl � |Vl|eFδn                                 (3-29)                                               

  and then, when we think about that the elements of the Ybus matrix which could be 

put in polar form: 
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                                                         y/l � |y/l|eFφPn                           (3-30)                                                        

then we could transforms equation(3-27) into following (3-31); 

                         P/ � Re oQ|y/lVlV/|eFDδngδP�φPnE
0

l1�
p                                    	3 � 31
  

By unfolding the real part of the Equation(3-31), we could get: 

                                  P/ � ∑ |y/lVlV/| cosDδl � δ/ � φ/lE      0l1�            (3-32)     

From equation(3-32) we have, upon differentiation: 

                     _`P  _qW � �Uy/FVFV/U sin	δF � δ/ � φ/F
                    (3-33) 

         we put the above partial derivative part into equation(3-25) and we could 

get following final formulas for computation of αFG�  and  βFG�  : 

αFG� � rFG sinDδF � δGE
|V/|UVFU|VG| Z 1

Uy/FUUVFU sinDδF � δ/ � φ/FE 

                                                                             � �|sPX||OX| 9/0	qXgqP�tPX
[  

 βFG� � rFG cosDδF � δGE
|V/|UVFU|VG| Z 1|y/G||VG| sin	δG � δ/ � φ/G
 

                                              � �
UsPWUUOWU 9/0DqWgqP�tPWE[                        (3-34) 

       When ,we get the equation above, we could also put the equation() with the 

above equation together, we could then compute the partial derivate result. However, 

because the two equations combined together are too long for calculation. This 

situation need much more computing time. So, we get[]:for the typical system 

parameter the double sum contributes only an insignificant part of the equation above, 
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and for the most situation we should therefore be able to use following approximate 

but timesaving formula for the equation(3-35): 

               _`a_`P u 2 ∑ 	PGα/G � QGβ/G
0G1�       (3-35) 

  

3.4 Two calculation methods analysis: 

        From the above derivate process we could get the new optimal way to find 

the optimized location and size for Distributed Generator. As we induced in the 

chapter2 , This is the IA(improve of the analysis method) . Now, how to final get the 

size and location and then to bring them back to the power loss calculation to get the 

optimized power loss is the problem that we are now trying to figure out. Here we get 

two analysis methods to get the results. 

   3.4.1 Method 1 start from analysis the real injection power: 

       The first method [5]is following the equation(3-35) in 3.3, as we get: 

                             _`a_`P u 2 ∑ 	PGα/G � QGβ/G
0G1�  

       We could see that there are two different situations in the above equation, 

that is when i=j, and when i~=j. Based on this, we get: 

                    α//P/ � β//Q/ � ∑ 	α/FPF � β/FQF
vF1�Fc/ � 0             (3-36)     

      so we get: 

                                              P/ � �
αPP ?β//Q/ � ∑ wα/FPF � β/FQFxvF1�Fc/

A              (3-37) 
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         In this formula, we know that the Pi is the real power injection at node i. It 

does not represent the demand power or the generation input power. But, it has a 

relationship with the two. That is : 

                                                        P/ � P,+/ � P,/                        (3-38) 

Where the PDGi is the real power injection from DG placed at node i, it is the input 

real power of the node. The PDi is the demand load of the node i. To put all the 

equations above here, we could get: 

              P,+/ � P,/ � �
αPP Zβ//Q/ � ∑ 	α/FPF � β/FQF
vF1�Fc/

[             (3-39) 

       When we get this formula, we could easily find that only PDGi  in the formula 

is uncertain variable for each bus. And as we know the meaning of the equation is to 

get the minimize size of Pi for minimizing the Power loss. So the equation here which 

could give us the Distributed Generator result is the equation that give us the 

optimized Distributed Generator size. Beside this size of the Distributed Generator, all 

the other sizes which is being put in the bus will lead to a higher power loss in the 

whole system.  

         Here, when we install the DG into the optimal bus i in the system. because 

of node equation: Pi=PDGi-PDi (3-38), we know that the Pi must be changed. This will 

result to the change of voltage and angle in bus i. And then , all the voltages and angle 

will changed after running the base flow. At last the coefficient y z�{ | will change 

which may involve the value of the power loss. In the paper[], author explain that 
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numerical result shows the accuracy gained in the size of DG by updating y z�{ | is 

too small to involve power loss result. In this way, we could get the optimized size 

and location for the DG by easily avoid recalculating the power flow again. Then, as 

the same theory, we could easily get the optimized power loss. The following is the 

computational procedure for this method: 

        Step1: Sep up the modeling with power world simulator: 

        Step2: Run the base power flow. 

        Step3: Get the optimal size for the DG in every bus in the system with 

Eq(3-39). 

        Step4: Calculate the loss using Eq(3-16) on each bus which has being 

placing  by                                                                      

optimized DG(we get this DG in step3). 

        Step5: Confirm the bus which make the power loss minimum while the DG 

is placed. Here is the optimum location for DG. 

         step6: Run the load flow with DG to get the final result. 

 The algorithm figure for the method is at the end of this chapter: 

3.4.2 Method 2 start from analysis the real DG input power:  

      In this method, we may need to step back the power loss equation: 

               P- � ∑ ZαFGDPFPG � QFQGE � βFG	QFPG � PFQG
[0F1�G1�
          (3-39) 
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       Now , as we start to consider the DG real power earlier. we may need to 

consider the relationship between the real power part and reactive power part from 

DG[43], let us first assuming: 

                a � 	sign
 tan	cosg�	PF,+

                        (3-40) 

so that we get: 

                                                       Q,+/ � aP,+/                          (3-41) 

   here we need to know: 

 sign=+1, DG injecting Q; 

 sign=-1: DG consuming Q; 

  then, as we know the relationship on the node is: 

P/ � P,+/ � P,/ 

                                                        Q/ � Q,+/ � Q,/ � aP,+/ � Q,/             (3-41) 

     Here, we take the formulas above (3-41), back to the power loss equation, then 

we could get : 

                    P- � ∑ ∑ Zα/FZ	P,+/ � P,/
PF � 	aP,+/ � Q,/
QF[�β/FZ	aP,+/ � Q,/
PF � 	P,+/ � P,/
QF[[vF1�v/1�          (3-42) 

    Now, we are going to do the partial derivative of the above equation. Here we do 

the derivative of DG,PDG; 

          
_`a_`��P � 2 ∑ Zα/FDPF � aQFE � β/F	aPF � QF
[vF1� � 0              (3-43) 

then we take Eq(3-39) in so that we get: 



 

53 
 

α//	P/ � aQ/
 � β//	aP/ � Q/
 � QDα/FPF � β/FQFE
v

F1�Fc/
 

                                                                                        �a ∑ 	α/FQF � β/FPF
vF1�Fc/ � 0         
(3-44) 

It followed by: 

X/ � Q	α/FPF � β/FQF

0

F1�Fc/
             

                                                  Y/ � ∑ 	α/FQF � β/FPF
0F1�Fc/                        (3-45) 

here, we put the equation(3-41)(3-42)(3-43)(3-44)(3-45) together, then, we get: 

α//	P,+/ � P,/ � a�P,+/ � aQ,/
 � β//	Q,/ � aP,/
 � X/ � aY/ � 0          (346) 

 As we get the above equation, we could find out optimal size of DG at each bus i to 

minimizing loss : 

                                              P,+/ � bPP	`�P��h�P
�dPP	�`�Pgh�P
g�Pg��P��bPP�bPP             (3-47) 

    In the above equation(3-47), we find the "a" is the variable that we need to 

confirm in order to get the PDG result. The following is the table that hold the different 

situations for a and Power factor (PFDG):  

 PF,+ a Sign  Equation  

Type 1 1 0 N/A P,+/ � P,/ � 1α// Zβ//Q,/ � QDα/FPF � β/FQFE
v

F1�Fc/
[ 

Type 2 0 � N/A Q,+/ � Q,/ � 1α// Zβ//P,/ � Q	α/FQF � β/FPF

v

F1�Fc/
[ 
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Type 3 (0,1) c +1 P,+/ � α//	P,/ � aQ,/
 � β//	aP,/ � Q,/
 � X/ � aY/a�α// � α//  

 

Q,+/ � aP,+/ 
Type 4 (0,1) c -1 

                                 Table 4 

       Now, as we are trying to list out a common situation not a special one, we 

need to confirm the a as a common situation. in the paper[], the author give us an 

explanation that the power factor of demand here is almost the same as DG when we 

want to get the minimized total power loss. So if we do: 

P, � ∑ P,/v/1�          

                                                           Q, � ∑ Q,/v/1�                           (3-48) 

   We then, get the following: 

                                                                 PF,+ � PF,                       (3-49) 

       when , we step back to the node relationship equation it is easy to get this 

result  only because when the p.f of demand are the same the p.f of DG, the input 

could be transmit into the demand at the maximum way, which means the total loss is 

minimum.  

     Then, as the same consideration of the former method. We could again, get 

the P,+/. And then, we could also get the total power loss after optimized. 

      Here we also list out the computational procedure 

       Step1: Step up the modeling with power flow: 
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       Step2: Run the base power flow. 

       Step3: Calculate the Power Factor with Eq(3-48) and Eq(3-49) 

       Step4: Get the optimal size for the DG in every bus in the system with 

Eq(3-47). 

       Step5: Calculate the loss using Eq() on each bus which has being placing by                   

optimized DG(we get this DG in step3). 

       Step6:Confirm the bus which make the power loss minimum while the DG is 

placed.  Here is the optimum location for DG. 

       Step7: Run the load flow with DG to get the final result   

 3.4.3 Comparison of the two methods: 

      Here , we use two methods to analysis the result for getting the optimal DG 

power. We could find out that there are two main difference in the two method: 

1.  When we do the partial derivative, method one do it by inject power Pi while the 

second method do it by DG power PDG.  

2.  The second consider more about the p.f. factor problem. It consider all the 

possible for the PF. 

   We will compare the result of the two methods in Chapter 5 to see if they have 

relationship or some majority difference. 
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Chapter 4  Methods and tools proposed in the paper: 

        In the paper, we start with improve of analysis (IA) method. We make some 

improve on the original formula for power loss. The aim of this to set up the 

relationship between the power loss and base power flow data. In this way, we only 

need to run the power flow and the date from the bus part of system(not the whole 

system) if we hope to get the power loss. Comparing with if we take consideration of 

the whole system. This way is much more easier. Then, when we set the analysis 

modeling, we get the optimized size and location by the modeling. In realize the 

optimization process, we use Power World simulator to get the power flow result. 

Then, we compute the optimization of location and size of the Distributed 

generation(DG) by Matlab. We write a code for the optimization and use the result of 

by Power World to get the DG location and size. Then, we take the result back to IA 

modeling and use Power World to calculation the optimized power loss.  

        So, In this chapter, we list out the major method and tools that had been put 

into the research process. And then, give them a brief analysis. 
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   4.1  IA method: 

In the chapter2, we give IA a brief explanation. Improve of analysis called IA is a new 

method to analysis the problem. Unlike the traditional optimization method, it does 

not list out all the objective function and possible constraints. It start with a deeper 

analysis of the optimal process, and try to get a clearer and direct relationship between 

the uncertain varieties and give data and information. In this way, we could get the 

calculation process faster.  

        In this paper, we start but did not follow with the original power 

relationship as follow (4-1):   

                                    P/ � jQ/ � ∑ S/0/1� � ∑ V/J/�0/1�                          (4-1)   

Then, we take the matrix calculation (4-2): 

	A � B
4 � A4 � B4 

	AB
4 � B4A4 

          	A4
4 � A                              

    Z789 * R � jX � ?r�� … r�0
r0� r00

A � j ?x�� … x�0
x0� x00

A                  (4-2) 

 and vector calculation (4-3), 

                        P/ � jQ/ � J7894 Z7894 J789� � J7894 Z789J789�                         (4-3)      

And then, use an abbreviate method to reduce the induced formula to get the 

following  power loss equation: 

    
_`a_`�P � ∑ _

_`P ZαFGDPFPG � QFQGE � βFG	QFPG � PFQG
[0F1�G1�
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          Then, in the two method they all use partial derivative to get the optimal 

size for DG. No matter where they start to calculate, they are all based on an analysis 

about the derivative. Here, we use a derivative method to avoid listing out too much 

useless constraints which may lead us to a much more complicated calculation 

process.[5][42] 

   

    4.2 Power World simulator for power flow: 

      As the introduction above, we know the usage of Power World simulator is to 

get the base power flow data. We introduced the Power World in chapter 2.  

      Power World simulator is a software that specialist for the power system 

calculation. And it is really fast and convenient to compute the power flow. 

Comparing with using Matlab code to calculate the power flow, it is really a better 

choice. Because when you use the Matlab code. [44]You need to spend a lot of time 

on writing the code and then to make sure the logic of the code is right. After you 

finish all of these, you may still not be able to get the good result. Then, you need to 

check many "spot" such as input data, angle expression, step consequence and so on. 

In the Power world, what you only need to is to set up the modeling of your system. 

And then, you only need to input all the starting data for the power system(they are 

Voltage, angel of voltage, real power and reactive power for the demand and 
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impedance). Although, we have to say, we need spend some time on set up the 

modeling, it is much more faster than writing a code for calculating the power flow.  

       In this research, the power world give many help while doing the power flow 

calculation. First, when we input the generator as follow (fig 4-1):[45][46] 

 

Fig 4-1 Generator input 

the system will remainder you (Figure 4-2   

 

  Fig 4-2 System reminder 

         This is remind you that you need to add bus first because if you do not 

have bus there is no place to lay the generator on. This is a simple problem. But it 

proves that the window and operator of the power world simulator is friendly. It will 

help to check the step and remind you problem(you could see that the generator 

without bus to place is red). 
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         Then, you start to put the bus on as follow (figure 4-3). 

 

Fig 4-3 Bus figure in Power World 

         In this way, you have to choose the orientation of the bus like (figure 4-4):  

 

Fig 4-4    Bus information 

then, you input all the data easily as introduced in the chapter 2. 
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Fig 4-5 Bus Option 

and also (figure 4-6): 

 

Fig 4-6  Bus Option 

         If the bus1 is slack bus , you need to pay attention to the blanks i quote in 

red line. 

        After these, we need to add the generator to the slack bus (4-7): 
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Fig 4-7 Generator Option 

      Here, we do not need to a starting data for the generator power. we could give 

an 0. Because we assume that the generator have a very big capacity that could hold 

whatever we out in the system. So, we only need to do is to give a wide constraint of 

the power( second red circle). So does the voltage. 

       And also as (figure 4-8): 
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Fig 4-8 Information Table 

       So we get (figure 4-9): 

 

Fig 4-9 Generator figure with information in Power World 

           Here, we note that when you install the generator in the right way, the 

generator do not have colors. 

          Before we put transmission line into the system , we also need to put 

bus2 in to the system: 
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Fig 4-10   Bus option revise 

Here, we need to put the data of the voltage in to the bus(here, it is bus2). 

 In this way we could put the bus2 on as follow (figure 4-11): 

 

Fig 4-11 Set up the modeling 
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     Following this, we could put the transmission line on to the system. We put it 

between the bus1 and bus2, as follow (figure 4-12): 

 

Fig 4-12 Branch Option table 

Here, we need to put the data for the bus into the line information (figure 4-13): 
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Fig 4-13  Draw the modeling 

 At last, we need to put a load on bus2 (figure 4-14) 

 

Fig 4-14 Load Option revise 

    Here, we only need to complete the information in Load information part. we 

give the size of power and the display. But, in some case that need us to calculate the 

optimize power flow with the economic dispatch, we need to open the blank "OPF 

load Dispatch" at the right of "load information". 

      Then, we get the following figure (figure 4-15) 
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Fig 4-15 Draw some basic part of modeling 

      When, we finish this, we could then continue to add other 31 buses, 31 

transmission lines and 31 load to get the 33 bus and 38 bus (In )  

   

 4.3 Matlab for optimal modeling: 

     For doing the optimization, we choose the Matlab. We edit a paragraph of code 

to realize the optimization. It indeed take us some time to edit, to address , to get the 

result. It is fastest we could try to do the optimization right now. However, its 

calculation function is great and the result will be list out clearly.[47][48]  

     There is not too much to say on the Matlab. However, when we talk about 

optimization we could say something about Matlab. When we think about doing the 

calculation for optimization[49].he Matlab simulator has an unique advantage. When 

we are dueling with a optimization problem, no matter you are doing the traditional 

optimal problem(like objective and constraints) or new method for optimal(like IA 
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method), calculation is always a problem[50]. The Matlab simulator could put all the 

data and equations into a huge matrix. And then, Matlab would use its great 

calculation ability for matrix to do the optimization problem. It is the best to use 

Matlab to duel with the optimization problem. [51]  
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Chapter 5: Result and analysis: 

     In this chapter, we first use a 33 P-Q bus modeling to make a comparison for 

method 1 and method 2 to find a better method. Then, we use to the better method to get 

the result for another 16 test bus modeling (but P-V bus ). 

  5.1 Result for method 1: 

     The following Figure, figure 5-1 is a 33 bus modeling built in the power world.  

 

                    Fig 5-1 The modeling for 33 bus 
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                      Fig 5-2 The original result for 33 bus 

 

     By using the modeling in this figure, we find the calculation for power flow is 

at the minimize size of 1 MW(This is why the real and reactive power on the buses 

are all keep on zero). As we run the Power World with the model, we could get the 

total power loss is 0.5 MW with DG  

  5.1.1 For method 1: 

      Then, we input the data to Matlab code for optimal the location and size for 

DG(the data is gain from 33 bus modeling after the power flow calculation above). 

Then , we get the follow result, figure5-3 and figure 5-4, as follow: 
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Fig 5-3  Result for method1 on relation by bus No. and PDG 
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Fig 5-4  Result for method1 on relation by PDG and PL 

  In the figure 5-4, we could see that the optimal DG location should be in bus6 or 

bus7. Then, we mark the bus 6 and bus 7 as follow figure 5-5, 5-6: 

 

Fig 5-5  The power loss on bus 6 for method 1 
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Fig 5-6  The power loss on bus 7 for method 1 

      Here, we get the approximate result of power loss after placing in bus 6 and 

bus 7, they are: PL6=0.01314MW, PL7=0.01312MW;  As the result are so similar, we 

place the optimal DG back in bus 6 and bus7 with their own optimal DG size in 

Figure 5-1. In this case we get the figure as follow figure 5-7 and 5-8:      

 

Fig 5-7 Optimal DG put on bus 6. 
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Fig 5-8 Optimal DG put on bus 7. 

      After running the modeling in figure 5-7 and figure 5-8, we could finally get 

the power loss result they are in figure 5-9 and 5-10: 
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Fig 5-9  The Power Loss when put DG on bus 6 for method 1 

 

Fig 5-10  The Power Loss when put DG on bus 7 for method 1 

        Here, we could get total power loss after putting in the optimized DG. As 

we get :   
s � �P� � Q� 

So, here, for bus 6, it is 0.12MW, for bus 7 it is 0.11MW(The result here is shown in 

power world detail result sheet.) 

  5.1.2 For method 2: 

       In the method 2, we firstly use the modeling in figure 5-1 again to get the 

result for the power flow data. Then, we input the data to the Matlab code for the 

method 2. Here, we get the following result figure 5-11 and 5-12: 
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Fig 5-11  Result for method2 on relation by bus No. and PDG  
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Fig 5-12  Result for method2 on relation by bus No. and PDG  

 

 

 

Fig 5-13  Result for method 2 on relation by PDG and PL 

      Here again, we get the approximate result of power loss after placing in bus 6 

and bus7 again, they are: PL6=0.008521MW, PL7=0.008750MW;  As the result are 

again similar to each other, we now settle down the optimal DG back in bus 6 and 

bus7 with their own optimal DG size in Figure 5-1. In  this case we get the figure as 

follow figure 5-13 and 5-14: 
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    Fig 5-13  The power loss on bus 6 for method 2 

 

Fig 5-14  The power loss on bus 7 for method 2 

     After get this figure, we still want to put the optimized DG back to the bus 6 

and bus 7, the modeling for these two are exactly the same as in figure 5-7 and 5-8. 
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     By doing these, we could then run the modeling as same as in figure 5-6 and 

5-8. The follow two figure is the result of simulating for exactly power loss. 

 

  

 

      Fig 5-15  The Power Loss when put DG on bus 6 for method 2 
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Fig 5-16  The Power Loss when put DG on bus 7 for method 2 

     Here, So, here, for bus 6, it is 0.13MW, for bus 7 it is 0.12MW. 

 

5.2 Comparison of the two method: 

      The method 1 start with 
   _`a_`P  , while the method 2 start with  

_`a_`��P  .   The 

idea for where it started are different. Comparing with the method 1, the mtheod2 are 

more directly on getting the result. It is because what we need to get is the PDG . But, 

as the relationship equation Pi=PDGi-PDi . We could find the PDi in the equation is a 

known matrix. In other words, it is a constant. So, whatever you do the derivative by 

Pi  or by PDGi , they should be the same in Mathematics aspect. In this way, we could 

easily find out that the Optimized result of Power loss for the two method are the 

same.  
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       However, we are still able to find some differences between the two method 

that may involve the final result as follow:  

      First of all, we explain that the two method have the same meaning in 

Mathematics aspect. But, while we are now analysis on a physical problem. The 

Physics meaning for the Pi and PDGi is different. the Pi is the different between all the 

input power and the demand as the PDGi is only a part of the input power. Why we use 

Pi=PDGi-PDi is only because we want to set up a convenient modeling for Mathematics 

iteration. This process must cause some difference while calculating.  

      Secondly, We could see that in the method 1.We use the directly do the partial 

derivative 
   _`a_`P  to get the equation: 

P/ � 1α// Zβ//Q/ � Q	α/FPF � β/FQF

v

F1�Fc/
[ 

 In the method 2, before we do the partial derivative, we have consider the Q, the 

reactive power. We set up the relationship between Q and PDG as following: 

Q/ � Q,+/ � Q,/ � aP,+/ � Q,/ 

This make the Q participate into the optimization process. As we all know that The Q, 

the reactive power is also a part in the power flow process, the method 1 which ignore 

the reactive in getting the optimal DG size and location should have bring in a little 

difference with the reality value for the final result.  
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      Then, even we get the same result in the two method, the optimal location and 

the approximate power loss are different. We were seeking for the reason of this 

situation and then find out that because we use the Power World simulator to do the 

calculation of power flow. As the Power World Simulator are always trying to do an 

rounding (Half adjust) while Matlab will do an exactly calculation. And as we use the 

Matlab to do the approximate power loss and use the Power World to do the exactly 

power loss. If we see the figure 5-4,5-5, 5-12,5-13, the Matlab calculator show the 

result as in 0.000001. But in figure5-8, 5-9 ,5-14, 5-15, the Power World calculator 

show the result as in 0.1. It is easy understand why we get the difference in 

Approximate power loss but the same in final power loss.  

      What is more, when we compare the two method using the calculation by 

Matlab, which is the approximate power loss calculation. we could find the difference 

between the PDG6 and PDG7 (the 1st and 2nd optimal point)is 0.000184 for method 1 

and 0.000020 for the Method 1. It is not hard to see that in the method 1 the optimal 

point would be easier confused than in method 2. And also, if we open the detail 

result sheet, we could calculate the power loss by add all the bus together. we will 

find the different. This is a important evidence that the method 2 is the better choice 

than the method 1. Because our propose is to find out the optimized DG location, we 

do not want to find a second optimal location by any reason. 
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  5.3 Application:        

         We compare the two methods above. And now, we find out the better 

method is method 2. So, in this section, we will use the method 2 to analysis another 

test bus (13 bus) , and we also run Power World with the model, we could get the total 

power loss is 1 MW . The modeling is shown below: 

 

 

 

                   Fig 5-17 The modeling for resident area  
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                Fig 5-18 the original loss for resident area 

      Then , we get the data from the power flow result by Power World Simulator. 

And we input the data into the Matlab code for method 2. In this way, we could get 

the result for DG size and the relationship between the power loss and PDG. 

 

Fig 5-19  Result for resident area on relation by bus No. and PDG            
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Fig 5-20  Result for resident area on relation by PDG and PL 

       Look at the figure5-20, we could see that the bus 5 is the optimized point for 

DG location. SO we revise the figure 5-17 to add the DG as follow: 

 

Fig 5-21    Add DG on bus 5 for resident area modeling 

     Then, we run the modeling and get the result  and find out the following: 
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Fig 5-22  The Power Loss when put DG on bus 5 for 13 bus 

     From the figure, we could see that we get a prefect result on reducing the Power 

loss for the system. 

      Then, following the above case , we take out another 34 bus system (as 

following figure 5-23 modeling.   
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Fig 5-23 34 Bus system modeling 

        Also, we first get the power flow calculation and get (figure 5-24) :  

 

Figure 5-24 Power flow result for original 34 bus system 

        Then, we still use the Matlab to get optimal location for DG. And we find 

the Bus 17 is the optimal location and the optimal size is 3MW. So we add this 

generator to Bus No.17 on the system. And finally we get the power flow calculation 

result as following (figure 5-25): 

 

Figure 5-25 Power flow result after adding the DG on 34 bus system  
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     From the figure 5-25, we find is the power loss of the system is being reduced 

from 0.4MW to 0.3MW. This is the result we need.      
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Chapter 6 Conclusion: 

      In this paper, we use two new methods to do the optimization in order to get 

the optimal size and location for DG in the power system. The two methods are 

based on the IA (Improve of Analysis) method. Then, we use the Power World and 

Matlab together to get the result.  

      We could divide the paper into two parts. The first part is analysis part. in 

this part we have two analysis methods. And then, the second part is simulation parts. 

We use two simulation tools. Then, we make a comparison both on the two methods 

and two tools. At last we apply the better method in another system for the optimal 

the DG size and location.  

       In comparing the two methods, we list some similar point first, and then 

find some differences that may influence the result (on choose the optimal location). 

Then, in the comparison of two method. We could find out the advantage and 

disadvantage of two tools. 

        For the Power World, we find its convenience in set up the modeling, and 

its friendly operation on power flow calculation. However, its inexactly calculation 

result will lead final result to an unclearly situation For the Matlab, we have to write 
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and correct the problem of the Matlab code. It will take us quite a long time. But, its 

result accuracy and exhibits are very good for common research. 

        Finally, we recognize the method 2 is a better method to get the optimal 

size and location for DG. Because it has a direct Mathematics thinking. Then it has a 

more complete consideration. At last, it has a better choice scheme of the optimal 

DG location. All these make the method 2 a better choose for solving the DG 

problems.   
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Chapter 7 Future works: 

      As we compared two methods and use the better one to solve a reality 

problem, we get a good result for the work. However, we still need to do further 

works on this topic.  

        First of all, when we compare the two method. We start from the old 

methods themselves. We step back to the theoretical induced process to prove that 

the base theory which support the two method is right. However, there are some 

mathematic approximation in inducing process. As the comparison result did not 

show a big difference, we could not may an exact conclusion that the second method 

is always the better choice to solve the DG problem. So, it is better to have a clear 

check of the mathematics inducing process in the future and trying to get a better 

mathematics theory to refine the inducing process in order to get the inducing result 

less relay on the approximation. Because the more approximation we made, the less 

accuracy we get for the result.    

Secondly, we should realize that the accuracy of result shown in Power World is not 

very clear. Though we could get the difference in the detail result table, the Case 

Summary table shows the unclear result. We  have to use the Matlab 
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result carve to see the difference. It may confuse the reader of this paper. So, we 

should step back to think about Power World software itself. Although, we know that 

the Power world is more strong and more friend in calculating the power flow and it is 

easy to get the result. However , we need to consider another software that are similar 

in the function of Power World but has a clearer result showing table. In this way, we 

could have a transparent result showing to support our result.  

        Third, we could find out that the system that we use as modeling is a little 

idealized. the following figure(Figure 7-1) is a part of Fig 5-1. In this figure below, 

we  

 

Fig 7-1   Bus details 

circle out the load on each bus. There is nothing except the load on each bus. 

However, there are many conductor and inductor in the reality electrical power 

productions and projects. In reality, many electrical parts in power system contain  

the conductor and inductor(like some light contain inductors and some battery include 

conductor). What is more? The transformer are always include in the power system. 

These must influence the result a lot.. This also make the result not that clear. In the 

future work, we need to think about solving the modeling with conductor and inductor. 
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In that situation, method should be changed a little. But it will bring these methods 

more close to the reality power electrical productions and projects. So, we will find 

some new modeling with conductor and inductor on buses and find the DG solution 

for them.    

      Finally, as the model we use in the paper is at small scale. We should find a 

bigger power system as research modeling for being closer to reality. 
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